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1.  
2.  
3.  
4.  
5.  

6.  
7.  

The list of terms used
The Guide – this document.
The system – the  software system.Auto PSIM
Server – computer with installed  software package.Auto PSIM
Traffic – the flow of vehicles.
Vehicle Tracer – the interface object designed for viewing the recognized LP numbers, the types and speeds of vehicles, as well 
as for searching the LPR database and creating reports for specific time periods.
Traffic Monitor – the interface object designed for monitoring vehicle movement.
fps – frame frequency. Number of video stream frames processed by software per 1 second.

3



1.  
2.  
3.  

1.  
2.  

3.  
4.  
5.  
6.  

1.  
2.  
3.  

Operator's Guide. Introduction
On page:

The purpose and structure of the Guide
The purpose of the Auto PSIM system
Recommendations for using the Auto PSIM system

The purpose and structure of the Guide

The Guide is an informational reference designed for users of the  system with Operator access rights responded for Auto PSIM
operation with  software and corresponding interface objects.Auto PSIM

The Guide contains the following material:

General description of the  software system.Auto PSIM
How to use the  software system.Auto PSIM
Description of the user interface of the  system.Auto PSIM

The purpose of the Auto PSIM system

The  software system is designed for automated traffic monitoring and control, and has the following functionality:Auto PSIM

License plate number recognition.
Centralized events registration and processing, generation of notifications and control commands according to flexible 
algorithms.
Searching matches between the recognized plate number and the numbers in the database connected to Auto PSIM.
Creating the photo and video archive.
Determining the overall traffic parameters and the parameters of individual vehicles.
Software scalability.

Recommendations for using the Auto PSIM system

The  software is installed as an extension to the Axxon PSIM software package.Auto PSIM

For proper operation of the  system, please follow these recommendations:Auto PSIM

Follow the job description accurately.
Use the system for the intended purpose only.
Do not use the computer with  installed, to run other software which is not part of the  package.Axxon PSIM Axxon PSIM
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1.  
2.  

1.  
2.  
3.  

Starting and closing the system
Please check the working condition of all hardware components – connections, cameras, etc – prior to starting the system.

The system can be started using one of the following methods:

Automatically. The system starts automatically after the operating system boots up.
Manually. To start the system manually, in the  menu, select ->  -> , or use Start Programs Axxon PSIM Client Workstation
the corresponding shortcut on the Desktop.

Access to the system can be protected by a password. In this case, enter your password to start the system.

To shut down the system, do the following:

Point the mouse to the upper right corner of the screen, the main control panel will open.
Click the icon on the panel.
Select  in the menu that opens.Shutdown

The shut down process will start, the password will be required if set.
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Note.

The system can be set up to forbid the shut down. Then, the  item is not present in the menu.Shutdown
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Using the Traffic Monitor interface object
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Displaying the current traffic information in table 
form
The table with current traffic parameters is shown in the  sub-tab of the  tab.Table Current value

Displaying the current traffic parameters by lane in a table.

Displaying the current traffic parameters by direction in a table.
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The system can be set up to display the traffic parameters by lane or by traffic movement direction. In case of the by-lane display, the 
columns correspond to traffic lanes, and rows correspond to traffic parameters. In case of the by-direction display, the columns 
correspond to traffic directions, and rows correspond to traffic parameters.

Note.

The  parameter for each lane corresponds to the time when the last vehicle passed. The Time of registration Time of 
 minus the  is taken as the beginning of the period to base the statistics on, while the registration Statistics update period

current moment is taken for the end of the statistics period.
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Displaying the current traffic information in 
graphic form
The charts with current traffic parameters are displayed in the  sub-tab of the  tab.Charts Current value

Displaying the charts of current traffic parameters by lane.

Displaying the charts of current traffic parameters by direction.
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The system can be set up to display the traffic parameters by lane or by traffic movement direction.

The  tab consists of several sections corresponding to the lanes or the traffic movement directions. Each section consists of Charts
several subsections displaying some particular sets of traffic parameters in graphic form.
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1.  
2.  

3.  

4.  

Creating a request for traffic statistics
To create a request for traffic statistics, use the  tab.Statistics

To create a request for traffic statistics, do the following:

Select the preferred type of statistics presentation by clicking the  or the  tab ( ).Table Charts 1
Select the sampling period – , , , or (specifStatistics per day Statistics per week Statistics per month Selective statistics 
y the period manually) ( ).2
If  is chosen, enter the beginning and the end date/time of the statistics period in the  and the Selective statistics Beginning

 fields ( ).End 3
Click the  button to create or update the statistics ( .Refresh 4)
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Displaying traffic statistics in table form
The traffic statistics in table form are displayed in the  sub-tab ( )  of the  tab ( ).Table 2 Statistics 1

The traffic statistics are displayed in the following tree structure:  ->  ->  -> Recognizer name Movement direction Lane Vehicle 
. The statistics data for each level of the tree is shown.type

Note.

To refresh the displayed statistics, click the  button ( ).Refresh 3
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Displaying traffic statistics in graphic form
The traffic statistics in graphic form are displayed in the  sub-tab of the  tab.Charts Statistics

Note.

To refresh the displayed statistics, click the  button ( ).Refresh 1
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1.  
2.  
3.  
4.  

Saving traffic statistics to a file
The  tab ( ) allows saving the traffic statistics into a file.Statistics 1

To export the traffic statistics into a file, do the following:

Create and display the request for traffic statistics (see the  section).Creating a request for traffic statistics
Click the  button ( ).Save as 2
Enter the pathname in the window that opens and click .Save
The traffic statistics will be saved in the specified location in a CSV file.
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Using the Vehicle Tracer interface object
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1.  
2.  

3.  

Introduction
The interface object includes the following components:Vehicle Tracer 

On-line monitor – is designed for displaying the data about identified plates and for handling alarms.
Events monitor – displays video frame with a vehicle, which plate is being recognized at the moment and also identified 
number and speed.
Alarm window – is designed for displaying the data about vehicles in case of coincidence of recognized plates with plates 
which are stored on the external orientation database.

Note.

 and  components are optional and aren't displayed with corresponding system settings (see Events monitor Alarm window
the document ).Auto PSIM software package. Administrator's Guide
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1.  
2.  

a.  
b.  
c.  
d.  

e.  
f.  
g.  
h.  
i.  
j.  

k.  

l.  

m.  

3.  

Viewing the data about passing vehicle
The passing vehicle data is displayed in the window.Events monitor 

In the  window, the following data is displayed:Events monitor

License plate recognizer (the name of the corresponding object) ( );LPR channel 1
An image of a vehicle with a caption , which can contain the following data ( ):in the black area 2

date and time of receiving the vehicle data;
vehicle license plate;
country;
type of license plate (only for the , module, orVehicle type recognition module  RR vendor and model recognizer  AR MMR 

);module
vehicle speed;
vehicle direction;
speed, permitted on the controlled road area;
ID of speed detector;
control point—name of the camera that captured the vehicle;
vehicle vendor (only for the , module, or modVehicle type recognition module  RR vendor and model recognizer  AR MMR 

);ule
vehicle model (only for the , module, or moduVehicle type recognition module  RR vendor and model recognizer  AR MMR 

);le
vehicle color (only for the , module, or moduleVehicle type recognition module  RR vendor and model recognizer  AR MMR 
);
other information about the speed detector (see ).Setting up the frame sign parameters

Recognized license plate and the license plate image ( ).3

Note

The   component may not be displayed due to the corresponding system settings.Events monitor

Note

You can use the parameters of the  and registry keys to change the size FontSize.N TimestampFontSize.N 
of the black area containing captions and their font (see . For more information Registry keys reference guide
on working with the registry, see ).Working with Windows OS registry
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3.  

Note

If the license plate hasn't been recognized, the  message will be displayed in the field.UNDEFINED
If the characters of the recognized license plate are displayed incorrectly, it is necessary to change the font of 
the recognized license plate to the one that will contain all the characters of the corresponding country license 
plates (see ).Setting up the font of the recognized LP number
The image of the recognized license plate is compressed or stretched to fit the red frame. By double-clicking 
in a separate window, you can view the image of a recognized license plate. The set window sizes are saved 
after you restart the computer.

Note

In case the or  module is used for recognition, allowed speed, vehicle speed and ID of speed  AUTO-Uragan AR-Auto
detector are displayed only if the  module is connected.Speed traps server
In case the alarm is registered for a vehicle (overspeeding, and/or identification of a plate in the external plates 
database), the field with a video frame is highlighted in red ( ).2

20
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Viewing the data about the last identified vehicle
The last identified vehicle data is displayed in the  group of the  window (left area of this window).Last event Online monitor

Viewing the data about the last identified vehicle is performed in the following way:

Note

If there is selected in the identified vehicles protocol or in the alarms protocol, the data about this event will be an event 
displayed in the  (see , ).Last event group Viewing the protocol of the identified vehicles Viewing the alarms protocol
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1.  

2.  

3.  
a.  

b.  

c.  

d.  

The vehicle video frame with a caption is displayed in the filed ( ).1

The identified LP number and the LP image is displayed in the field ( ).2

Depending on the available data, the following information can be displayed in the box ( ):3
In the  field, the name of the LP recognizer is displayed (the name of the corresponding objecRecognizer LPR channel 
t).
In the  field, the country to which belongs the identified LP number is displayed.Country

In the  field, the date and time of receiving the vehicle information is displayed.Recognition time

Note

If the LP number hasn't been recognized,  message will be displayed in the field.UNDEFINED
If the characters of the recognized number are displayed incorrectly, it is necessary to change the font of the 
recognized number to the one that will contain all the characters of the corresponding country LP numbers 
(see ). Setting up the font of the recognized LP number
The image of the recognized license plate is compressed or stretched to fit the red frame.

Note

This field is not displayed when the  module is used for recognition.IV
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3.  

d.  

e.  
f.  

g.  
h.  

i.  

j.  
k.  

l.  
m.  
n.  
o.  
p.  

q.  

r.  

s.  

In the  field, the vehicle speed is displayed.Speed

In the  field, the speed limit allowed on this part of the road is displayed.Speed limit
In the  field, the difference between the captured vehicle speed and the speed limit allowed on this part of Speeding
the road is displayed.

In the  field, the identification validity rate is displayed in percent.Validity
In the  field, the vehicle's direction is displayed ( , , Direction Undefined, To the camera From the camera To the 

, ).right To the left
In the  field, the regional code of the recognized LP is displayed.Regional code

In the  field, the name of the video camera which captured the vehicle is displayed.Camera
In the  field, the data file about the triggered engine is displayed.SDK data file

In the  field, the camera location address is displayed.Address
In the  field, the camera ID number is displayed.Identificator (№)
In the  field, the certificate number is displayed.Certificate (№)
In the  field, the calibration expiration date is displayed.Calibration
In the Vendor and Model and Color field, the vendor and model and color of the recognized vehicle are displayed.

In the  field, the type of the recognized vehicle is displayed.Type

In the  and  fields, the class and the contents of the Dangerous goods class Dangerous goods composition
dangerous cargo are displayed correspondingly.

In the  field, the coordinates of the camera installation are displayed.GPS coordinates

Viewing the data about the last identified vehicle is complete.

Note

In case the or  modules are used for identification, and the  module  AUTO-Uragan AR-Auto Speed traps server
is not connected, zero speed value is displayed.

Note

Depending on the settings, the speed is displayed in km/h or mi/h.Vehicle Tracer 

Note

This field is displayed if the speeding event was registered, otherwise this field is absent.

Note

This field can be hidden (see ).Setting up the Vehicle Tracer interface window

Note

The  field is displayed only if the  module is used.SDK data file AR-Railway

Note

The Vendor and Model and Color fields are displayed only if the RR vendor and model recognizer is used. 

Note

This field is displayed only if the Vehicle type recognition module or the   and/ RR vendor and model recognizer
are used.

Note

The  and  fields are displayed only if the Dangerous goods class Dangerous goods composition AR-Auto m 
odule and the Hazard Identification Number Recognition Engine (ADR) are used.

23
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Note

In case an alarm for a vehicle, the reason of alarm is also displayed in the .was registered Last event group

Note

The data about any event selected in the identified vehicles protocol or in the alarm protocol can be viewed in the same way 
(see , ).Viewing the identified vehicles protocol Viewing the alarms protocol

A passing vehicle event can be created using a script (see ).Scripts used in the Auto PSIM software package
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1.  
2.  

3.  

4.  
5.  

Viewing the identified vehicles protocol
The identified vehicles protocol is displayed in the  window.Online monitor

To access to the protocol, go to the tab ( ). The identified vehicles protocol is a table which contains the information about Cars 1
identified vehicles ( ).2

For every vehicle (event) the following data is displayed:

Video frame of the vehicle ( ).3
Identified vehicle LP number ( ).4

Vehicle speed.

LPR channel ( ).5
Date and time of receiving the information about the vehicle ( ).6

For alarms, the information about reasons of alarms is also displayed (see ). The alarms which were not processed by Alarms operation
the operator, are highlighted with red, and processed alarms are highlighted with yellow (see ).Alarm processing

Note

If the LP number hasn't been recognized,  message will be displayed in the field.UNDEFINED
If the characters of the recognized number are displayed incorrectly, it is necessary to change the font of the 
recognized number to the one that will contain all the characters of the corresponding country LP numbers 
(see ).Setting up the font of the recognized LP number

Note

Vehicle speed is displayed only if the  module is connected.Speed traps server
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1.  
2.  

3.  
4.  

To view the detailed information about the event, do the following:

Left-click the required event.
As a result, the data about the vehicle will be displayed in the  group. Online update of the identified vehicles Last event
protocol will be suspended.
View the data about the event as described in the  section.Viewing the data about the last identified vehicle
To restore the online update of the identified vehicles protocol click the  button in the upper area of the  Trace Online monitor
window. 

Viewing the detailed data about the event is complete.

Note

Any alarm event is duplicated: first, an event message with a recognized LP number is received without an alarm, then the 
same message is received with alarm. You can hide the processed events (see ).Hiding the processed events in the protocol
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1.  
2.  

Alarms operation
Alarms operation is done in the  window.Online monitor

Alarm is triggered by one of the following ways:

Automatically – in case of overspeeding or vehicle's plate identification in the external database.
Manually.
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1.  

2.  
3.  

Manual alarm triggering
To enable the manual alarm triggering, do the following:

Left-click the required event in the identified vehicles protocol ( ).1

Click the  button ( ).Alarm 2
As a result, this event will be highlighted in red, and if it is the first alarm, the Alarms protocol tab will become available ( ). 3
For the alarm which was triggered by the operator, the cause of alarm is displayed ( ).Marked by the operator 4

28



Manual alarm triggering is complete.

Note.

For the information about alarms protocol, see .Viewing the alarms protocol
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1.  
2.  
3.  

Viewing the alarms protocol
The  tab located in the upper area of the  window ( ) automatically becomes available in case of the Alarms protocol Online monitor 1
alarm event. The alarms protocol is a table which contains the information about the vehicles for which the alarms were triggered ( ). 2

The alarms which were not processed by the operator, are highlighted with red, and processed alarms are highlighted with yellow (see 
).Alarm processing

To view the alarms protocol, do the same as to view the identified vehicles protocol (see ). The Viewing the identified vehicles protocol
only difference is that for an alarm the information about the alarm reason is also displayed:

Marked by the operator - means the alarm is triggered by the operator (the time of triggering is also displayed);
Is found in: <external database name> - means the identified LP is found in the external database;
Overspeeding - means the vehicle overspeeding is registered.

Detailed information about an alarm with the alarm reason is displayed in the  group (see Last event Viewing the data about the last 
). To view the detailed information about an alarm, do the same as to view the information about the event, identified vehicle

registered in the identified vehicles protocol (see ).Viewing the identified vehicles protocol

In case the identified vehicle LP is found in the , the information about the vehicle, stored in this base, will External Plates Database
be displayed in the field ( ). 3

Note.

The information about the last alarm is displayed on the tab.

Note.

Any alarm event is duplicated: first, an event message with a recognized LP number is received without an alarm, then the 
same message is received with alarm. You can hide the processed events (see ).Hiding the processed events in the protocol
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Note

To display the side panel, click the ( ) button.4
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1.  

2.  

Alarm processing
Alarm processing is done in the following way:

Left-click the alarm in the identified vehicles protocol or in the alarms protocol and click  button.Accept

As a result, the event will be highlighted with yellow.

Alarm processing is completed.
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Hiding the processed events in the protocol
It is possible to hide the processed events in the identified vehicles protocol and alarms protocol. To do this, click the  Processed Hide
button. As a result, when all alarms are processed, then the Alarms protocol tab becomes hidden.
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1.  

2.  

1.  

Viewing the alarm information in the Alarm 
window
Depending on the certain configuration, the  can be displayed automatically in the following cases:Alarm window

If the recognized license plate number coincides with the number stored in the external online monitoring database. As a 

result, the  sign will be displayed at the top of the alarm window.

If the alarm event was triggered manually. As a result, the  sign will be displayed at the top of the 
alarm window.

The following data is displayed in the :Alarm window

Event information ( ):1
Date and time when the alarm event was recorded.
License plate number.
Recognition server name that recorded the event.
Vehicle direction of movement relative to the camera.
Name of the external database.

Current state of the alarm event.

Note

The field with the n is hidden if the the alarm event was triggered manually.ame of the external database 
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1.  

2.  The description from the stolen vehicles database ( ): ID, LP number, storage time, search status, date and time of creation, 2
comment, full name of the operator who created the report.

Use buttons to scroll the alarm events ( ).3

To confirm the active alarm status, click the  button ( ). As a result the alarm will be marked as Confirmed (information sent) 5
received in the  window, and deleted from the . If the checkbox is set ( ), the confirmed alarm On-line monitor Alarm window Trace 4
will be deleted from all  in the distributed system.Alarm windows

To close the window of stolen vehicle report click the button ( ). If you click this button, the alarm status will not be No confirmation 6
changed in the  (alarm will not be processed).On-line monitor

Note

There can be the following states of the alarm event:

Not confirmed - a new event that has not yet been confirmed.
Processing... - an alarm event is confirmed, but the information has not yet been recorded to the 
database.
Confirmed - the alarm is confirmed and recorded to the database (you may not notice this state 
since the event is deleted from the Alarm window after a successful confirmation).
Error - the confirmation is not recorded to the database due to the heavy load on the Server. It is 
necessary to confirm the event again.

Note

The table with the description from the stolen vehicles database is hidden if the the alarm event was triggered 
manually.
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1.  

2.  
3.  

4.  

Adding comments to the events
It is possible to add the comments to the events. It can be done in the  window.Online monitor

To add a comment to the event, do the following:

Left-click the event in the identified vehicles protocol or events protocol. Online update of the protocol displayed on the screen 
will be suspended.

Click  button.Comment
Comments for license plate window will open in result.

Attention!

It is not possible to add the comments to the accepted events (highlighted with yellow).

36



4.  
5.  

6.  

In the  field ( ), specify a required comment.Enter new comment 1
Click the  button ( ) to add the comment to the event. Add 2

To view the comments to the event, left-click the required event in the identified vehicles protocol or events protocol. 
Comments will be displayed in the corresponding field ( ).1

Adding the comments to the event is completed.

Note

The  field ( ) displays the previous comments, if any, and the date Comments for license plate <LP number> 3
when they were added to this event.

Note

To display the side panel, click the (2) button.
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1.  

2.  

Printing and exporting the vehicle data
Printing and exporting the vehicle data is done in the following way:

Left-click the event in the identified vehicles protocol or events protocol. Online update of the protocol, displayed on the 
screen, will be suspended.

To build a report with vehicle data, click the  button ( ), which is located in the left corner of the bottom panel.Print 1
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3.  

4.  

The report preview program will be displayed.

If necessary, do the following operations with the report, then quit the report preview program by clicking the  -> File Exit 

 in the main menu, or by clicking the  button in the top right corner.viewer

The available operations for the report are listed in the table below.

Operation Operation invocation

Main menu item Context menu 
item

Toolbar 
button

Open the report, saved in .rsd or .xml File -> Open -

Save the report in .rsd or .xml File -> Save -

Export the report to one of the common formats File -> Export -

Print the report File -> Print -

Activate the «Hand» tool View -> Scrolling Scrolling

Zoom in the report pages View -> Zoom in Zoom in

39



4.  

Zoom out the report pages View -> Zoom out Zoom out

Enable dynamic scaling of report pages View -> Dynamic scaling Dynamic scaling

Zoom in the selected area of the report View -> Region scaling Region scaling

Scale in page size View -> In page size In page size

Scale in page width View -> In page's width 
size

In page's width size

Display pages in real size View -> Real size Real size

Enter or select from the list the required scale of displaying the 
report pages

View -> Set the scaling Set the scaling

Enable the nonstop paginal report displaying - -

Enable the page-by-page report displaying - -

Go to the first page Navigate -> The first 
page

The first page

Go to the previous page Navigate -> Previous 
page

Previous page

Go to the next page Navigate ->The next 
page

The next page

Go to the last page Navigate ->The last page The last page

Go to the certain page (open the dialog window) «Go to page» Navigate -> Go to page - -

Display the previous view Navigate -> Back Back

Display the next view Navigate -> Forward Forward

Find the required characters in the report Document -> Find Find

Update the report Document -> Update Update

Edit the report (open the editing program) Document -> Edit the 
report

Edit the report

Display table of contents - -

Display information about the program to view the report Help -> About program - -

Close the preview report program File -> Close - -

Printing and exporting the vehicle data is completed.

Note.

Operations with report files (opening, saving, exporting, and printing) are performed via the standard OS Windows dia
.log windows

Note.

To go to the required page, enter the page number in the  of the  dialog window and then Page № field Go to page
click .OK
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1.  

2.  

Viewing the video archive by event
You can view the video archive by event from a video camera which is used for the license plate recognition.

To view the video archive by event, do the following:

Select an event in the identified vehicles protocol or alarms protocol by left-clicking on it. As a result of the operation, the 
online update of the protocol displayed on the screen will be suspended.

Click the button ( ).Video archive 1
If the  object is selected for the video archive playback, the video surveillance window of the corresponding Monitor
monitor will switch to the archive playback mode. For details on working with the video archive, see the Axxon PSIM. 

, the most current version of the documentation is located in the ).Operator's Guide AxxonSoft documentation repository
If the  object is selected for the video archive playback (see AxxonOne monitor Setting up the joint operation of Auto 

), the interface window will open in the archive playback mode. For information on  and PSIM Axxon One Axxon One 
working with the video archive, see the , the most current version of the documentation is Axxon One. Operator's Guide
located in the ).AxxonSoft documentation repository

Viewing the video archive by event is completed.

Note

For this feature to work, the appropriate monitor should be selected on the settings panel of the  object (see Vehicle Tracer S
).electing the Monitor object for playing back the video archive
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1.  
2.  
3.  
4.  
5.  
6.  
7.  
8.  

1.  

Using filters in the protocols
You can select events to be displayed in the identified vehicles protocol and alarms protocol.

You can select the events using the following filters:

Speed.
Overspeeding.
License plate.
Validity.
Region.
Direction.
Alarm type.
Plate recognizers.

To select the filter, do the following:

Click  button in the  window ( ).Filter Online monitor 1

Attention!

Both displayed and hidden in the protocol events are saved in the recognizers database of the  software.Auto PSIM
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2.  

3.  

4.  

Filters dialog window will be displayed in result.

From the  list ( ) select the required filter, then specify the speed value(s) in the field(s) in km/h.Speed, km/h 1
The following speed filters are available:

No filtering — the event is displayed in protocols with any vehicle speed;
More — the event is displayed in protocols if the vehicle speed exceeds the specified value;
Less — the event is displayed in protocols if the vehicle speed is below the specified value;
Interval — the event is displayed in protocols if the vehicle speed is within the specified speed range.

From the  list ( ) select the required filter, then specify the overspeeding value in the field in km/h.Speeding, km/h 2
The following overspeeding filters are available:

Note

Available range for specifying the  filter values is 0-300.Speed
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4.  

5.  

6.  

7.  

8.  

9.  

10.  

11.  

No filtering — the event is displayed in protocols with any vehicle overspeeding;
More — the event is displayed in protocols if the vehicle overspeeding exceeds the specified value.

From the  list ( ) select the required filter and then in the field enter the LP number or its part which identification Number 3
leads to event displaying in protocols.
The following LP filters are available:

No filtering — the event is displayed in protocols with any vehicle LP number;
Register — the event is displayed in protocols if the vehicle LP number exactly matches the specified value;
Contains — the event is displayed in protocols if the vehicle LP number contains the specified value.

From the  list ( ) select the required filter of the LP recognition validity percentage, then specify the percentage value Validity 4
in the field(s).
The following validity filters are available:

No filtering — the events are displayed for those vehicles which plates are recognized with any validity;
More — events are displayed in the protocol if the recognizing validity is higher than the specified value;
Interval — vehicle event is displayed in the protocol if the recognizing validity of vehicle plate belongs to the specified 
range of values.

From the  list ( ) select the required region filter, where the vehicle has been registered, and then enter the region  Region 5
number in the field.
The following region filters are available:

No filtering — the events are displayed in protocols for the vehicles, registered in any region;
Equal — the events are displayed in protocols for the vehicles, registered in the specified region.

From the  list ( ) select the vehicle direction for which the event should be displayed in protocols.Direction 6
The following direction filters are available:

No filtering — the events are displayed in protocols with any vehicle direction;
From camera — the event is displayed in protocols if the vehicle was moving away from the camera;
Towards the camera — the events are displayed in protocols if the vehicle was moving towards the camera;
Undefined — the events are displayed in protocols if the vehicle direction was not determined.

From the  list ( ) select the alarm type. Only alarms of the selected type will be displayed in protocols.Alarm type 7
The following alarm type filters are available:

No filtering — the events are displayed in protocols with any alarm type or its absence;
Overspeeding — the events for which overspeeding has been registered are displayed in protocols;
LP found in database — the events for which the LPs have been found in the external plates database are displayed 
in protocols;
Alarm set by operator — the events, initialized manually, are displayed in protocols;
Running a red light — the events for which the red lights running has been registered are displayed in protocols;
Entered the oncoming lane — the events for which the entering the oncoming lane has been registered are 
displayed in protocols;
Crossed the stop line — the events for which the crossing the stop line has been registered are displayed in 
protocols;
Stop over crosswalk line – the events for which the stopping on the crosswalk line has been registered are displayed 
in protocols.

In the  ( ) group set the checkboxes for those LP recognition Servers, which data should be displayed in Plates recognizers 8
protocols.
Click  to save filters settings and close the  dialog window ( ). OK Filters 10

Note.

The overspeeding value is calculated as the difference between the recorded vehicle speed and the speed, 
permitted in the controlled area of the road.

Available range for specifying the  filter values is 0-100.Speeding

Note.

The value specified for the  and filters may include usual characters and characters Register Contains «*» 
which stand for an unidentified LP character. If the value contains one or several characters, only the LPs «*» 
which contain the unidentified characters in the specified combination, are displayed in the protocols.

Note

Available range for specifying the Validity filter values is 0-100.

Note.

To reset all the settings, click the  button ( ).Reset 9
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Filtering the events to be displayed in the protocols is complete.

Note

You can disable any filtering without changing the settings in the  dialog window. To do this, click the  button  Filters Show all i
( ). All the registered events will be displayed in protocols in result. To resume the usage of n the Online monitor window 2

filters, click this button again.
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1.  

Viewing the Vehicle Tracer errors

If there are no  errors, the  button in the right upper corner of  window is green .Vehicle Tracer Server status Online monitor

If errors are registered, the button is red .

To view the  errors, do the following:Vehicle Tracer

Click the  button.Server status
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2.  

3.  
4.  

5.  

6.  

The  dialog window will be displayed in result. Errors

The data about the occurred errors is displayed in the field ( ).1
The list of all possible error sources is displayed in the field ( ): LPR channels and/or external databases. Current error sources 2

are marked by the  sign, idle sources are marked by the  sign.
To delete the data about the errors and close the  dialog window, click the  button ( ).Errors Clear 3

To close the  dialog window without deleting the data about the errors, click the  button.Errors

Viewing the  errors is completed.Vehicle Tracer
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Creating the additional Online monitor 
components
It is possible to create the additional interface components. To do this, double left-click the  Online monitor Events monitor
component. As a result, the additional  component will be displayed in the center of the screen.Online monitor

Working with  components is similar to working with the main component.Additional Online monitor Online monitor 
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Searching the events in the recognizers databases
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1.  
2.  
3.  

Opening and closing the Event search in the 
Recognizers DBs window

On this page:

General info about searching the 
events in the recognizers databases
Opening and closing the Event 
search in the Recognizers DBs 
window
Opening the Event search in the 
Recognizers DBs window using the 
Windows command line

General info about searching the events in the recognizers 
databases
You can search the events in the the recognizers databases via the dialog window.Auto PSIM Event search in the Recognizers DBs 

The full list of operations provided to the operator in the window , is the following:Event search in the Recognizers DBs

Searching the events, stored in the local or remote recognizers databases.Auto PSIM 
Printing the search results reports.
Creating the personal LPs database ( database).Active tracking 

Opening and closing the Event search in the Recognizers DBs 
window
To open the window, click the  button in the interface object.Search Online monitor 
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As a result, the window will be opened.Event search in the Recognizers DBs 

To minimize the  window, click the ( ) or ( ) buttons. As a result, the window will be Event search in the Recognizers DBs 1 2
minimized to the Taskbar but will continue working.

To close the  window, select the    item in the main menu ( ). As a result, the window Event search in the Recognizers DBs File Exit 3
will be closed completely.

Opening the Event search in the Recognizers DBs window using the 
Windows command line
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The window can also be opened using the Windows command line, even when the Event search in the Recognizers DBs Axxon PSIM
is unloaded. To do this, run the following command:

<Axxon PSIM installation directory>\Modules>VehiclePlateSearch.run "C:
\Users\<Username>\AppData\Local\Temp\PlateSearchSettings_1.xml"

Command example:

C:\Program Files (x86)\Axxon PSIM\Modules>VehiclePlateSearch.run "C:
\Users\User\AppData\Local\Temp\PlateSearchSettings_1.xml"

"C:\Users\UserName\AppData\Local\Temp\PlateSearchSettings_1.xml" - is the path to the PlateSearchSettings_1.xml configuration 
file, which is generated each time you click the  button in the  interface window in accordance with the current Search Online monitor
system configuration. If the system configuration has changed, then to re-generate the file, click the  button again or make Search
changes to the file manually.

Note

If you work in the window with the  unloaded, then the vehicle frames Event search in the Recognizers DBs Axxon PSIM
and license plate images will not be displayed.
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1.  
2.  
3.  

Configuring the events search
On the page:

Selecting the recognizer databases for the events search
Configuring the search results
Configuring the video archive

Events search is set up in the following order:

Select the database, where events should be searched.
Configure the displaying of search results.
Configure the video archive.

Selecting the recognizer databases for the events search 

To select the recognizer databases for events search, first select the servers where the required LPR databases are. To do this, in the 
main menu of the  window, in the  item, select the required server names. Event search in the Recognizers DBs Servers To select 
all system servers, click   .Servers Select all

Configuring the search results

Event search results are displayed in the table. You can choose which table columns should be displayed and which shouldn't, add new 
columns and also edit the columns displayed names.

To configure the search results displaying, do the following:

Note

Each time you open the  window, the access to the selected servers is checked. If Event search in the Recognizers DBs
any of the selected servers is unavailable, then after the timeout expires, the header of the search results table will display a 
list of servers to which it was not possible to connect, and the header itself will be highlighted with red. If all servers are 
available, the header will be highlighted with green.

The timeout for connecting to the selected  servers is set on the settings panel of the  module Auto PSIM Vehicle Tracer
window (see ).Setting up the Vehicle Tracer interface window

If you use the Server/Remote Administrator’s workstation and Remote Client configuration, you must set the value of the 
string parameter of the registry key to enable the event search (see VehiclePlateSearch.UseRestIp=1 Registry keys 

).reference guide
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1.  

2.  

In the main menu of the , click .Event search in the Recognizers DBs  Settings

As a result the  dialog window is displayed. The search results displaying is configured on the  tab. Settings Configure fields

In the field ( ) set the checkboxes for the columns that should be displayed in search results table.1

Column name (by 
default)

Column content

Frame Video frame with a vehicle

License plate Video frame with vehicle LP number

Number Identified LP number

Region number Region number of the identified number

LP region Region of the identified LP number

Recognizer name LPR channel object name, corresponding to the vehicle detector

Vehicle speed Vehicle speed

Country The country of the recognized LP number

Date Date and time of the vehicle identification

Recognizer address LP detector address

Valid speed, km/h Speed in km/h permitted on the road area covered by the detector

Speeding, km/h Vehicle overspeeding in km/h

Direction An indication that the vehicle was moving towards the detecting camera

Note

To display all the available columns in the search results table, set the  ( ). If this Select\deselect checkbox 2
checkbox isn't set, the search results table is not displayed.
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2.  

3.  

a.  

b.  

c.  

d.  

Validity, % LP identification accuracy in percent

Alarm time Time of the LP detection alarm registration

Alarm initiated by Name of the operator who initiated the alarm

Alarm accepted by Name of the operator who processed the alarm

Comment from external DB Comment on the external plates DB added by the operatorvehicle report in the 

Alarm accepted at Time of the LP detection alarm acceptance by the operatorAuto PSIM 

Alarm handing delay, sec Time between registering the alarm and its acceptance by the operator

Comment Comment on the event added by the operator

Alarm type Alarm type (overspeeding or vehicle identification in the external plates databases)

Alarm processed An indication that the alarm was accepted by the operator

External DB An indication that the alarm was found in the external plates database

Red-light phase start time Time of the red-light phase start during which the alarm was registered (if the Red lights 
 module is used)running

Time passed since the red-
light phase start

Time between the red-light phase start and the alarm registration (if the  Red lights running
module is used)

Category Vehicle category identified by license plate

Camera Name of the video camera which captured the vehicle

Type Vehicle type (if the  Vehicle type recognition module and/or the RR vendor and model 
are used)recognizer 

Vendor Vehicle vendor (if the is used)RR vendor and model recognizer 

Model Vehicle model (if the is used)RR vendor and model recognizer 

Vehicle color Vehicle color (if the is used)RR vendor and model recognizer 

Frame from a synchronous 
camera

Video frame from a synchronous video camera displaying a vehicle 

Dangerous goods class Class of the dangerous cargo (if the  module and the Hazard Identification Number  AR-Auto
Recognition Engine (ADR) are used)

Dangerous goods composition Contents of the dangerous cargo (if the  module and the Hazard Identification  AR-Auto
Number Recognition Engine (ADR) are used)

To add a new column to the search results table, do the following:

Click  ( ). As the result the dialog window will be displayed.Add 3 Configure fields 

In the  field, specify the name of the column in the connected recognizer database, which Field name in the DB
content should be displayed in the search results table ( ).1
In the  field, specify the name for this column which should be displayed in the search Field name in the interface
results table ( ).2
Click  to save the applied changes and close the  dialog window ( ).Save Configure fields 3

Note

Click  to close the window without saving any changes ( ).Cancel 4

55



4.  
a.  
b.  
c.  

d.  

5.  

1.  

2.  

3.  

To edit the column name in the search results table, do the following:
In the  group select the column, which name should be changed ( ).Configure fields 1
Click  ( ).Edit 4
As a result the  dialog window with the disabled  field is displayed.Configure fields Field name in the DB

In the enabled  field, specify the new column name and save the changes (see steps 4.3-Field name in the interface
4.4).

Click  to save the changes and close the  dialog window ( ).OK Configure fields 5

Configuring the displaying of the search results is completed.

Configuring the video archive

Video recordings of the events are displayed in the video archive. To configure the video recordings playback, do the following:

In the main menu of the , click .Event search in the Recognizers DBs  Settings

As a result the  dialog window is displayed.Settings
Go to the  tab ( ).Configure video archive 1

From the  drop-down list, select the Overlay mode ( ).Overlay 2

Note

Click  to close this window without saving any changes ( ).Cancel 6
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3.  

4.  

5.  

The overlay modes are presented in the table.

Overlay mode Description

No Videos from the video cameras are not processed by the video card

Overlay 1 Videos from the video cameras are processed as one stream

Overlay 2 (set by default) Videos from the video cameras are processed independently of one another

In the  field, set the cursor according to the required video compression rate ( ).Compression 3
Default—means the original compression rate, size and quality of the video corresponds to the video image that is 
sent to the server.
None—means minimal compression rate, full video size, best quality.
Maximum—means maximum compression rate, minimal video size, worst quality.

To save changes click  ( ).OK 4

The configuring of the video recordings playback is completed.

Note

Overlay is used to process the video using the video card and  libraries, before it is displayed. Overlay allows Direct X
to improve the image due to optimization of the pixel color settings. At the same time, the CPU load is reduced as the 
video is processed with the resources from the video capture card.
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1.  
2.  

1.  

2.  

Creating a search query
On the page:

Creating a search query by recognized vehicles
Creating a search query by alarms
Starting a search

You can form a search query:

By recognized vehicles (the tab).Search by vehicles 
By alarm events (the  tab).Search by alarms

Creating a search query by recognized vehicles

To create a search query by recognized vehicles, do the following:

Go to the tab ( ).Search by vehicles 1
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2.  

a.  

b.  

c.  

d.  
e.  

f.  

g.  
i.  

ii.  

In the group:Vehicle's license plate 

From the  drop-down list ( ), select a logical construction, used for uniting several elements of the Search operation 2
key phrase, which correspond to the LP numbers or their parts that are being searched:

AND—for searching by numbers, containing all the elements of the key phrase;
OR—for searching by numbers, containing at least one element of the key phrase.

In the field ( ), enter the key phrase. The elements of the key phrase can be separated by comma " " or semicolon " ".3 , ;

Picture-
characters

Description of a 
picture-
character

Example   of search query

% Any number of any 
characters

Search query  returns LP numbers, containing the elements , A%385%78 A 3
 and , divided by any number of characters, for example 85 78 AO38578 and 

A385MK78

_ 
(underscore)

Any single character Search queries  and return the LP number _91_AT_7  T9__AT07 T919AT07

[] Any single 
character within the 
range [A-E] or in 
the set [ABCDE]

Search query  returns LP numbers, containing the sequence of [E-M][2-5]53
four characters. The sequence ends in , the first character belongs to the 53
range , the second one belongs to the range , for example, E-M 2-5 K453MH02,
M253BT63

[^] Any single 
character outside 
the range [^A-E] or 
the set [^ABCDE]

Search query  returns LP numbers, containing the sequence of [^E-M]499
four characters. The sequence ends in , the first character does not 499
belong to the range , for example E-M B499BK57 and H499578

Set the  checkbox ( ) if it is necessary to display all numbers.License plate not recognized 4

Set the  checkbox ( ) if it is necessary to display partially recognized numbers.Partly recognized 5
Set the  checkbox ( ) if it is necessary to display the numbers that contain a space between 'Space' in car number 6
the characters.
Set the  checkbox ( ) to display the numbers with the errors (character mismatches), the Acceptable error amount 7
amount of which is indicated in the drop-down list.
From the  drop-down list ( ), select the type of vehicle search:Report type 8

Passes—standard search.

Note

The key phrase can include usual characters and picture-characters in the required combination.

Note

The  is available only if the logical construction is selected in the License plate not recognized checkbox OR 
 t.Search operation drop-down lis

59



2.  

g.  

ii.  

h.  

i.  

3.  

4.  

5.  

Escort vehicles—search for all vehicles that have been recorded near the specified vehicle within the time 
interval set in the  parameter.Interval before/after, s

In the  field ( ), specify the time in seconds within which it is necessary to search for the Interval before/after, s 9
vehicle.

In the  field ( ), specify the minimum number of vehicle records within the time set in Min. number of occurrences 10
the  parameter.Interval before/after, s

In the  group, set the checkboxes for those regional codes, the events for which must be returned during Regional code
search.

In the  group, set the checkboxes for those regions, the events from which must be returned during search.LP region

In the  group, select color of regional code and basic color of the license plate.LP colors

Note

This parameter is available if the  value is selected in the  drop-down list.Escort vehicles Report type

Note

This parameter is available if the  value is selected in the  drop-down list.Escort vehicles Report type

Attention!

Only those regional codes are displayed, the license plate of which has already been recognized earlier, since this 
information is received from the database of recognized license plates.

Attention!

Only those regions are displayed, the license plate of which has already been recognized earlier, since this 
information is received from the database of recognized license plates.

Attention!

Only those license plate colors are displayed, the license plate of which has already been recognized earlier, since this 
information is received from the database of recognized license plates.
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6.  

7.  

8.  

In the  group, specify the time range within which the required events have been registered. By default, this range Date/Time
is not activated (the  and  checkboxes are clear). To activate it, set the  and/or  checkboxes and then click the from to from to

 button and in the appeared calendar, set the required date. Enter the required time in the field  and/or . If you  From To
select only the lower or upper limit, the search query returns the events, registered before or after the set time, respectively. 
To disable the search by date and time, clear the  and  checkboxes.from to

In the  group, set the checkboxes for those plate recognizers, the events from which must be returned Plate recognizers
during search.

In the  group, set the checkboxes for those external databases, the events of finding the recognized number from External DB
which must be returned during search.

Note

Information about objects deleted from  isn't displayed in the  group. To search by Axxon PSIM Plate recognizers
deleted servers of plate recognizers, in the  menu of the  window, sView Event search in the Recognizers DBs elect 

.Show deleted

After this, all deleted LPR channels are displayed in the  group. Set checkboxes for those plate Plate recognizers
recognizers which you want to use during search.

Note

The  group contains a list of all databases that have ever been used together with the External database Vehicle 
module, but, by default, databases deleted from  aren't displayed in the list. To search by deleted Tracer Axxon PSIM

databases, in the  menu of the  window, select .View Event search in the Recognizers DBs Show deleted
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8.  

9.  

10.  

11.  

12.  

a.  

b.  

c.  

d.  

From the  group, select the required filter of vehicle speed and then enter the threshold values of vehicle Registered speed
speed. The following speed filters are available:

<not important>—events of the vehicle, moving with any speed will be returned;
more—events of the vehicle, moving with a speed, exceeding a threshold value, will be returned;
less—events of the vehicle, moving with a speed, not exceeding a threshold value, will be returned;
interval—events of the vehicle, moving with a speed, belonging to a specified interval threshold values, will be 
returned;

From the  drop-down list, select the required filter by the direction of vehicle movement. The following direction Direction
filters are available:

<no matter>—events of the vehicle, moving in any direction relative to the license plate recognition camera will be 
returned;
undefined—events of the vehicle, which direction of movement is undefined, will be returned;
from the camera—events of the vehicle, moving away from the license plate recognition camera will be returned;
to the camera—events of the vehicle, moving towards the license plate recognition camera will be returned;
to the right—events of the vehicle, moving to the right of the license plate recognition camera will be returned;
to the left—events of the vehicle, moving to the left of the license plate recognition camera will be returned.

In the  group, set the checkbox for the country, the events from which must be returned during search.Countries

In the  group:Comment

From the  list ( ), select a logical construction, used for uniting several elements of the key phrase, Search operation 1
corresponding to the comments to the events that are being searched for:

AND—for searching by comments, containing all the elements of the key phrase;
OR—for searching by comments, containing at least one element of the key phrase.

In the field ( ), enter the key phrase, containing one or several elements separated by a comma and corresponding to 2
the comments to the events, which are being searched for, and which were specified in the  window Online monitor
(see ).Adding comments to the events
Set the  checkbox ( ) to include the uncommented events in the search.Empty comment 3

As a result, all external databases deleted from the system are displayed in the list. Set checkboxes for those 
databases which you want to use during search.

Attention!

Only those countries are displayed, the license plate of which has already been recognized earlier, since this 
information is received from the database of recognized license plates.

Note

This parameter is available if the OR logical construction is selected in the Search operation drop-down list.
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12.  

d.  
13.  

14.  

15.  

16.  

17.  

Set the  checkbox ( ) to include only the commented events in the search.Non-empty comment 4
From the  list, select the required validity filter and then enter the threshold of validity values. The following validity Validity
filters are available:

<not important>—events of the vehicles, which numbers have been recognized with any validity, will be returned;
more—events of the vehicles, which numbers have been recognized with validity, exceeding the entered threshold 
value, will be returned;
less—events of the vehicles, which numbers have been recognized with validity, not exceeding the entered threshold 
value, will be returned;
interval—events of the vehicles, which numbers have been recognized with validity, belonging to the specified interval 
of threshold values, will be returned.

In the  field, set the checkboxes for the cameras, the events from which must be returned during Recognition cameras
search.

In the Vendor group, set the checkbox for the vendors, from which vehicles you want to return events during search. 

In the  group, set the checkbox for the vehicle models, the events from which you want to return during search.Model

In the  group, set the checkbox for the vehicle types, the events from which you want to return .Type during search
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18.  

19.  

1.  

2.  

3.  

In the  group, set the checkbox for the vehicle colors, the events from which you want to return .Vehicle color during search

In the  group, set the Category checkbox for those categories of vehicles, the events from which you want to return during 
search.

To clear the tab from the entered search criteria, click the button.Search by vehicles   Reset 

Creating a search query by alarms

To create the search query by alarms, do the following:

Go to the  tab ( ).Search by alarms 1

Repeat steps 2-8 of the  section as applied to the interface elements of Creating the search query by recognized vehicles
the  tab.Search by alarms
From the  list, select the required speed filter, permitted on the controlled road area and then enter the Permitted speed
threshold speed values in km/h. The following filters of the permitted speed are available:
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3.  

4.  

5.  

6.  

7.  

8.  

<not important>—events, registered on the road area with any permitted speed will be returned;
more—events, registered on the road area with any permitted speed, exceeding the entered threshold value will be 
returned;
less—events, registered on the road area with any permitted speed, not exceeding the entered threshold value will be 
returned;
interval events, registered on the road area with the permitted speed, that belong to the entered threshold value —
interval will be returned.

From the list, select the required filter according to the alarm handling delay and then in the fields, Alarm handling delay, s 
enter the threshold values of delay time in seconds. The following filters of alarm handling delay are available:

<not important>—alarm events, accepted in any time after being registered or unaccepted at all, will be returned;
more—alarm events, accepted with a delay, exceeding the entered threshold value, will be returned;
less—alarm events, accepted with a delay, not exceeding the entered threshold value, will be returned;
interval—alarm events, accepted with a delay, belonging to the entered threshold value interval, will be returned.

From the  list, select the required alarm processing filter. The following alarm processing filters are Alarm processed
available: 

<no matter>—both processed and unprocessed events will be returned;
alarm is not processed—only unprocessed events will be returned;
alarm processed—only processed events will be returned.

In the  group, set the checkboxes for the operators who received the alarm events to display these events Alarm accepted by
in the search query.

In the  group, set the checkboxes for the alarms, which must be returned in the results of a search query:Alarm type

Alarm is set by operator—manually initiated alarm events will be returned;
Entered the oncoming lane—events, for which entering the oncoming lane has been registered, will be returned;
Marking rules violation—events, for which the violation of marking rules has been registered, will be returned;
Parking rules violation—events, for which the violation of parking rules has been registered, will be returned;
Plate number is found in the DB—events of the vehicles, which license plates have been found in the external 
database, will be returned;
Red light violation—events, for which running a red light has been registered, will be returned;
Red light violation at intersection—events, for which running a red light at intersection has been registered, will be 
returned;
Run over stop line—events, for which stopping over the stop line has been registered, will be returned;
Speeding—events, for which speeding has been registered, will be returned;
Stop over crosswalk line—events, for which stopping over the crosswalk line at the stoplight has been registered, 
will be returned.

Note

This parameter is available if the  or a  value is selected in the  <not important> larm processed Alarm processed
list (see above).
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8.  

a.  

b.  

9.  

10.  

11.  

In the   group:Comment from external DB

From the  list ( ), select the logical construct which is used to combine several elements of the key Search operation 1
phrase, that correspond to the comments to the events you are searching for in external databases:

AND—to search for comments that contain all elements of the key phrase;
OR—to search for comments that contain at least one element of the key phrase.

In the field ( ), enter a key phrase consisting of one or more elements, separated by commas, that correspond to the 2
comments to the events you are searching for in external databases that are specified in the  group (see External DB C

).reating the Active tracking database
From the  list, select the required speeding filter and then enter the threshold values of speeding in km/h. The Speeding
following filters of the speeding are available:

<not important>—events of the vehicle, moving with any speeding or with the absence of it, will be returned;
more—events of the vehicle, moving with speeding, exceeding the entered threshold value, will be returned;
less—events of the vehicle, moving with speeding, less than the entered threshold value, will be returned;
interval—events of the vehicle, moving with speeding, in the entered range of threshold values, will be returned.

From the  list, select the required filter for the red light start and then in the fields, enter the threshold Red light shows at, s
values in seconds. The following filters of the running a red light are available:

<not important>—events of the vehicles, which violated a red light, will be returned;
more—events of the vehicles, which violated a red light after the entered threshold value of the red light start, will be 
returned;
less—events of the vehicles, which violated a red light before the entered threshold value of the red light start, will be 
returned;
interval—events of the vehicles, which violated a red light within the entered range of threshold values of the red light 
start, will be returned.

Note

This parameter is available if the  checkbox is set in the  group.Speeding Alarm type

The value of speeding is calculated as a difference between the fixed vehicle speed and the speed, permitted 
on the controlled area of the road.

Note

This parameter is available if the Red light violation checkbox is set in the Alarm type group.
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11.   In the  field, select the required operators who initiated alarm events. The corresponding alarm events will Alarm initiated by
be displayed in the search results.

To clear the tabSearch by alarms  from the entered search criteria, click the Reset button. 

Starting a search

After forming a search query by vehicles or by alarms, click the Find button.

As a result, a table with search results is displayed:that match the entered search criteria 

Note

This parameter is available if the Alarm is set by operator checkbox is set in the Alarm type group.
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If the  report type was selected, the search results table looks like this:Escort vehicles
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1.  

2.  

3.  

4.  

5.  

6.  

Viewing, printing and exporting the search results
Columns of the  table are displayed according to the settings configured in the  dialog window (see Search results Configure fields Co

).nfiguring the events search

The description of the columns content is given in the same section of the Guide.

To navigate in the results table, use the following interface elements:

button go to the first page of the table;—

button go to the previous page of the table;—

field go to the required page of the table;—

field the number of pages in the table;—

button go to the next page of the table;—

button go to the last page of the table.—
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You can print or export the search results as a report (see ), as well as export to the JPG file (see Printing the search results report Expo
).rting the search results to JPG files

You can sort the search results within a page by clicking the corresponding column. 

You can sort the search results by date on all pages by clicking the  column.Date

Note.

To go to the required page, enter its number in the field , and then press on the keyboard.Enter 
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1.  

2.  

Printing the search results report
The event search results can be printed as a report. To do this, do the following:

In the main menu of the window, click ( ).Event search in the Recognizers DBs File  Print 1

As a result, the report preview program will launch.
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2.  

If the  report type was selected:Escort vehicles

Perform the necessary operations with a report in the report viewing window. All operations in this window are similar to those 
described on the page .Printing and exporting the vehicle data

If there are more than 1000 entries in the search results the following message will be displayed before the preview report program 
launch.
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Click Yes to continue. Click No to return to change the search criteria.

Note

If the search results contain more than 1000 entries, the report may not be generated, because Windows does not allocate 
more than 2 GB of memory to the x86-bit processes.
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1.  

2.  

3.  

Exporting the search results to JPG files
The events search results can be exported to JPG files. For each event, the following objects will be created:

a JPG file containing the frame from the main camera;
a JPG file containing the frame from the  camera with the *_secondary.jpg name (if the  camera is synchronous synchronous
configured);
an archive containing meta data in the module format (if Debug4 mode is enabled). This functionality is required for ARENA 
integration with the TRIS.

To export the events search results to JPG files, do the following:

In the main menu of the Event search in the Recognizers DBs window, click File  Export ( )1 .

In the opened window select the folder in which the JPG files with search results are to be exported. Click .OK

As a result all JPG files corresponding to event search results will be exported to the specified folder. File names contain the 
following information:
detection tool ID, detection tool name, date and time, license plate, country (if defined), photo type (for example, secondary 
indicates that a photo is taken from a second synchronous camera, if there is any).
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3.  

Exporting the events search results to JPG files is complete.
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1.  

2.  

Exporting the search results to CSV file
You can export the event search results to a CSV file.

To export event search results to a CSV file, do the following:

In the main menu of the Event search in the Recognizers DBs window, click File  Export to CSV (1).

In the opened window, select the folder in which the CSV file with search results is to be exported, and click Save.

As a result, a CSV file containing the search results will be created in the specified folder.

Exporting the events search results to a CSV file is complete.
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1.  
a.  
b.  
c.  
d.  

e.  
f.  
g.  
h.  
i.  
j.  

k.  

l.  

Previewing and printing the event data
To view the event data, double left-click the corresponding string in the search results table. The  dialog window will open.View event

In the  window, the following event information is displayed:View event

The main video frame with a caption in the black area which contains the following data ( ):1
date and time of receiving the vehicle data;
vehicle license plate;
counrty;
type of license plate (only for the ,  module, or Vehicle type recognition module RR vendor and model recognizer AR MMR

);module
vehicle speed;
vehicle direction;
speed, permitted on the controlled road area;
ID of speed detector;
control point—name of the camera that captured the vehicle;
vehicle vendor (only for the ,  module, or  Vehicle type recognition module RR vendor and model recognizer AR MMR

);module
vehicle model (only for the ,  module, or  Vehicle type recognition module RR vendor and model recognizer AR MMR

);module
vehicle color (only for the ,  module, or  moduleVehicle type recognition module RR vendor and model recognizer AR MMR
).

Note

By double-clicking in a separate window, you can view the frame with a recognized vehicle. The set window 
sizes are saved after you restart the computer.

You can use the parameters of the  and registry keys to change the size FontSize.N TimestampFontSize.N 
of the black area containing captions and their font (see . For more information Registry keys reference guide
on working with the registry, see ).Working with Windows OS registry
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2.  

3.  
a.  
b.  

4.  
a.  
b.  
c.  
d.  
e.  
f.  
g.  
h.  

i.  

j.  

k.  

5.  
6.  

Additional video frame if any ( ).2

Field ( ) with the following data:3
recognized license plate of a vehicle;
image of a recognized license plate.

Field ( ) with the following data:4
recognizer of a vehicle license plate;
country;
date and time when the vehicle license plate was recognized;
validity in %;
vehicle direction in relation to the license plate recognition camera;
name of the camera that captured the vehicle;
vehicle speed;
vehicle vendor (only for the ,  module, or  Vehicle type recognition module RR vendor and model recognizer AR MMR

);module
vehicle model (only for the ,  module, or  Vehicle type recognition module RR vendor and model recognizer AR MMR

);module
vehicle color (only for the ,  module, or  moduleVehicle type recognition module RR vendor and model recognizer AR MMR
);
type of license plate (only for the ,  module, or Vehicle type recognition module RR vendor and model recognizer AR MMR

).module
Vehicle data from the external LP database if the recognized LP has been found there ( );5
Comments to the event ( ).6

To print the Report or/and export it to one of the most commonly used formats, click the  button ( ). A program to preview the Print 7
report will launch. The vehicle data report will be displayed in the window of this program.

Note

By double-clicking in a separate window, you can view the frame with a recognized vehicle. The set window sizes are 
saved after you restart the computer.

Note

By double-clicking in a separate window, you can view the image of a recognized license plate. The set 
window sizes are saved after you restart the computer.
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Perform the necessary operations with a report and then quit the program by clicking the  ->  menu items, or by clicking the File Exit

 button (see step 4 in ).Printing and exporting the vehicle data
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1.  
2.  

1.  

2.  

1.  

2.  

3.  
4.  

Creating the Active tracking database
The  database is the  database and is filled up by operator via the  module.Active tracking Auto PSIM Vehicle Tracer

For total interaction between the  database and the  module the following conditions should be met:Active tracking Vehicle Tracing

The  database should be connected to  as an external plates database.Active tracking Auto PSIM
This external database should be used by the  module for analyzing the recognized license plates.Vehicle Tracer

If the following conditions are met, the interaction between the  database and the  module is performed Active tracking Vehicle Tracer
in the following way:

The operator adds the vehicle LP to the  database via the  module, and specifies the reason of Active tracking Vehicle Tracer
its adding. 
The  module compares the passing vehicle LP with the LPs stored in the  database. If the Vehicle Tracer Active tracking
correspondence between these LPs is established, the alarm event is generated with the location of the number in the 
corresponding database.

The  option is convenient to be used in the  distributed system, as it enables the operator at his workstation  Active tracking Auto PSIM
to notify the remote workstation operators about the vehicle that is to be captured.

The information about the vehicle is added to the  database as follows:Active tracking

Click the  ( ) in the main menu of the  window.External Plates DB 1 Event search in the Recognizers DBs

As a result the  dialog window will open.Internal SVDBs

Click  to add records to the database.Enter
Indicate the start and expiration date of the vehicle profile ( ). All alarm events about the number being in the suspect 1
corresponding external LP database will be guaranteed to be stored until the expiration of the vehicle profile, despite suspect 
the periodic procedure for clearing the archive of events (see ).Configuring the retention period of the database records

Note.

It is impossible to remove and change records except for changing the suspect via the Vehicle Tracer module vehicle 
status.profile 

All operator actions with the Active tracking database (for example, adding or deleting a suspect vehicle profile, 
changing the start or end date of the suspect vehicle profile) are logged.
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4.  

5.  

6.  

7.  
8.  

9.  
10.  

In the  field ( ) specify the vehicle number. To enter a two-line number, use two underscore characters License plate number 2
"__" as a line separator, for example: .123ABC__TH777
If it is necessary to check the fact of vehicle driving to the vehicle report by all boundaries, do the following:

set the  checkbox ( );Check the fact of driving 3
enter the time period for which it is required to check the fact of vehicle driving to the vehicle report by all boundaries (4
).

The  field ( ) indicates the current operator creating the vehicle profile.Operator 5 suspect 
In the  list ( ), set the check boxes for those  user rights that should receive an alarm event when the User rights 6 Axxon PSIM
LP number is found in the database. In order for only the current operator to receive an alarm event, it is necessary to uncheck 
all the boxes in the  list.User rights

If necessary, in the  field ( ) enter a description of the reason for creating the  vehicle profile.Additional info 7 suspect
Click  to save changes ( ).Save 8

Note

To receive alarm events, it is necessary that the selected user has full access to the  object, to External plates DB
which the vehicle profile is entered. If any restrictions are set in the user rights for the  suspect External plates DB
object, then users with such rights will not receive alarm events.

Note.

The suspect vehicle profiles added to the database receive the  status.Active
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11.  

12.  

13.  

14.  

15.  

16.  
17.  
18.  
19.  
20.  

Go to the  tab to change the status of suspect vehicle profile.All reports of vehicles found in DB

The table displays a list of all  in the database that the current operator has access to ( ):suspect vehicle profiles 1
In the  column, the LPs on the wanted list are displayed.Number
In the  column, the time of adding the vehicle report to the database is displayed.Date and Time
In the  column, the expiration time of the .End time suspect vehicle profile is displayed
In the  column, the reason by which the vehicle report is created is displayed.Comment
In the  column, the checkboxes are set for the active vehicle reports.Active
In the  column, the operator who added the vehicle report to the database is displayed.Operator
In the  column, the rights of users who will receive an alarm event about finding a number in the database User rights
is displayed.

The ,  and  columns can be edited. To do this, select the corresponding value in the Date and Time End time Comment
column, then double-click on this value or click on the  button ( ).Edit 2

To change the  status, in the  column ( ), set the check boxes for the that suspect vehicle profile Active 3 suspect vehicle profiles 
are active, or uncheck the boxes for those that are inactive.suspect vehicle profiles 
To search for the vehicle in the table, enter the search request in the  field ( ) and click the  button. A list of Find 4 Search
vehicles matching the search request will be displayed.

To remove the selected lick  ( ).suspect vehicle profile, c Delete 5
To save the changes, click  ( ).Save 6
To update the list of s, click  ( ).suspect vehicle profile Refresh 7
To save all suspect vehicle profile to a CSV file, click  ( ) and select the  item.s Change 8 Save to CSV
To load previously saved s from a CSV file, click  ( ) and select the  item.suspect vehicle profile Change 8 Import from CSV

Adding the vehicle data to the  is completed.External Plates DB

Note

You can sort the  by clicking on the name of the corresponding column.suspect vehicle profiles

Note

The columns ,  and  are not editable.Number Operator User rights

Note

The data is searched in the following fields: , , , .Number Date and Time Operator Comment
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1.  

2.  
3.  

Viewing the video archive by an event
Viewing the video archive by event can be initiated in three ways:

Right-click the required event, and in the contextual menu select the  option.Video archive

Left-click the required event, and on the keyboard push the  keys combination.Ctrl + M
Holding the  key, double left-click the required event.Shift

As a result, the video archive with videos of the event will open.

To close the video archive, click the  button in the right upper corner of the window.

Viewing the video archive by event is completed.

85



Description of the Auto PSIM user interface
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Interface description of the Vehicle Tracer object
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The Events monitor
The  contains the following interface elements.Events monitor

Description of the interface elements of the  window.Events monitor

Element number Description

1 Detector of the LP of the passing vehicle

2 A frame with a passing vehicle and a caption

3 Recognized LP number and a LP image
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The Alarm window
The  contains the following interface elements.Alarm window

Description of the interface elements of the Alarm . window

Element 
number

Element Description

1 Frame area with a caption Signed video frame with a moving vehicle

2 Total alarms Number of unprocessed alarm events

3 Information area about the captured event

Date/time Date and time when an alarm event was recorded

License plate Vehicle license plate number

Control server Recognition channel that captured an alarm

Direction Direction of vehicle movement relative to camera

Internal Vehicles DB External database of vehicle license plates

Note. The  fieldInternal Vehicles DB  isn't displayed if an 
alarm event was initiated manually
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State Current state of an alarm event

There can be the following states of an alarm event:

Not confirmed—a new event that has not yet been 
confirmed;
Processing...—an alarm event is confirmed, but the 
information has not yet been recorded to the database;
Confirmed—an alarm is confirmed and recorded to the 
database (you may not notice this state since the event is 
deleted from the Alarm window after a successful 
confirmation);
Error—confirmation isn't recorded to the database due to 
the heavy load on the Server. It is necessary to confirm 
the event again

4 Table with a description from Internal Vehicles DB Description from Internal vehicles database

Note. The table with description from Internal vehicles 
database isn't displayed if an alarm event was initiated 
manually

5 Buttons to move through alarm events in the list 
Go to the first alarm event in the list ; go to the 

previous alarm event in the list ; go to the next alarm 

event in the list ; go to the last alarm event in the list 

6 Trace If the checkbox is set, when an alarm is confirrmed, it 
disappears from all alarm windows in the distributed 
configuration; when an alarm isn't confirmed, it disappears 
only from the current alarm window. 
If the checkbox isn't set, when an alarm is confirrmed or isn't 
confirrmed, it disappears only from the current alarm window

7 Confirmed (Information sent) Confirmation of the alarm status of an event. If you click this 
button, an alarm is marked as accepted in the Online 

window. A window offering to print the alarm event monitor 
card is also displayed

8 No confirmation Close the alarm window. If you click this button, the status of 
an alarm event isn't changed in the window. Online monitor 
Alarm disappears from the Alarm window
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The Online monitor
The contains the following interface elements.Online monitor 

Description of the interface elements of the Online monitor.

Element 
number

Element Description

1 Area Information about the last passed vehicle or about an event, selected in the 
identified vehicles protocol or in the alarms protocol

2 Cars Access to the identified vehicles protocol

3 Alarms protocol When an alarm event occur, you can go to the  tab. This tab Alarms protocol
displays the video frame and the number of the most recent alarm event

4 Processed
Hide

Hide the processed events in the protocols
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5 Show All Enable/disable the pre-configured filters

6 Trace Resume the online update of the displayed vehicle protocol

7 Alarm Alarm initiated by the operator

8 Accept Alarm acceptance

9 Server status Go to the list of errors occurred in the  moduleVehicle Tracer

10 Database Display of the information from the external database

11 Event table Identified vehicles protocol or the alarms protocol depending on the activated tabs—
 tab or Cars Alarms protocol tab

12 Collapse/expand button Collapse/expand the panel with comments and external database

13 Comment Display of the comment to the selected event

14 Print Create the report with data about the selected event

15 Search Open the searching in the databases of license plate recognizerswindow for 

16 Video archive Go to the video archive of identified vehicles
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17 Filter Go to the filter settings used in protocols

18 Comment Comment to the selected event with specified date and time of the comment 
creation
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1.  
a.  
b.  

2.  
a.  

3.  
a.  
b.  

4.  
a.  

5.  
a.  

The Event search in the Recognizers DBs window
The  window contains the following interface elements.Event search in the Recognizers DBs

Description of the interface elements of the Event search in the Recognizers DBs window.

Element 
number

Element Description

1 Main menu The main menu, which you can use to perform the following operations:

The  command: File
Print the event search results.
Close the  Event search in the Recognizers DBs window.

The  command: View
Configure the display of remote servers and databases.

The  command: Settings
Configure the display of event search results.
Connect the recognizers databases.

The  command: Servers
Select the servers for searching the events.

The  command:Internal SVDBs
Edit the user "Active tracking" database

2 Search type 
tabs

Select the search type: by vehicles or by alarms
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3 List of fields 
for search 
query

Form the search query of the selected search type

4 Reset Clear the search form from the specified search criteria

5 Find Start the processing of the search query

6 Search results 
table

Display of the event search results in the form of a table

7 Navigation 
panel through 
search results 
table

Go to the first page of the search results ; go to the previous page of the search results ; 

go to the next page of the search results ; go to the last page of the search results , 
number of the displayed page from the total number of search result pages 
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The preview report
The preview report program window contains the following interface elements.

The preview report interface description is presented in the following table.

Element 
number

Description

1 Main menu for viewing the reports (operations with a file, operations of previewing and navigating the report, 
operation with a report, viewing the information about program).

2 Group of elements for operations with a report file (printing, opening, saving, exporting).

3 Group of elements for operations with a report (displaying, content, search, update, edit).

96



4 Selecting the scaling mode and the scale of displaying the report.

5 Zooming the report.

6 Selecting the mode of displaying the report (page-by-page, nonstop page-by-page).

7 Group of elements for navigation in the report.

8 Undo or redo the last action.

9 Field for displaying the formed report.
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The Traffic Monitor interface object
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Table panel of the Current value tab
The following figures show the  sub-tab of the  tab displayed by lane and by direction respectively (depending on Table Current value
the system setup).

Dispalying by lanes:

Displaying by direction:

99



The following table describes the elements of the  panel.Table

Field name Description

Time of registration The time when the last vehicle passed

Total number of vehicles Total number of registered vehicles of all types

Passenger cars The number of registered passenger cars

Trucks less than 11 m long The number of registered trucks less than 11 m long

Trucks from 11 to 14 m long The number of registered trucks from 11 to 14 m long

Trucks more than 14 m long The number of registered trucks more than 14 m long

Buses The number of registered buses

Registered speed of the vehicle The speed of the last registered vehicle, km/h

Vehicle length Total length of the registered vehicle, m

Average speed for all vehicles Average speed for all registered vehicles, km/h

Average speed for passenger cars Average speed for passenger car vehicles, km/h

Average speed for trucks Average speed for registered trucks, km/h

Distance between vehicles The distance between the last vehicle and the previous one, m

100



Road load Average road load, %

Number of speed overruns The number of speeding violations

Moving along the oncoming lane The number of moving along the oncoming lane events

Number of vehicle stops The number of vehicles stopped in the lane

Jam Traffic jam indicator

Number of incidents Total number of road rules violations for the lane (direction)
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Charts panel of the Current value tab
The following figured show the  panel of the  tab displayed by lane and by direction, respectively (depending on Charts Current value
the system setup).

Displaying by lanes:

Displaying by direction:
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The following table describes the elements of the  panel.Charts

Number

of element

Description

1 The Traffic Detection object name

2 The lane number or direction

3 Total number of vehicles registered for the lane (direction)

4 Indication of a traffic jam in the lane (direction)

5 Chart showing the number of vehicles in the lane (direction)

6 Chart showing the road load of the lane (direction), %

7 Chart showing the statistics for the average speed of different vehicles types

103



Table panel of the Statistics tab
The following figure shows the  sub-tab ( ) of the  tab ( ).Table 1 Statistics 2

The following table describes the elements of the  sub-tab.Table

Number

of element

Description

3 Set of elements for selecting the statistic frequency

4 Set of elements for entering the beginning and end dates and times of the traffic statistics period

5 The  button refreshes the displayed statistics.Refresh

6 The  button exports the displayed statistics to a fileSave as

7 Traffic statistics results
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Charts panel of the Statistics tab
The following figure shows the  panel ( ) of the  tab ( ).Charts 2 Statistics 1

The following table describes the elements of the  panel.Charts

Number

of elements

Description

3 Set of elements for entering the beginning and end dates and times of the traffic statistics period

4 The  button refreshes the displayed statistics.Refresh

5 The  button exports the displayed statistics to a fileSave as

6 Set of elements for selecting the statistic frequency

7 The  object nameTraffic Detection

8 The lane number

9 Incident statistics for the lane
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10 The road load chart

11 Chart showing the number of vehicles in the lane
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